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Goals

@ esri

Understand what spatial analysis is.

Understand why spatial analysis is a unique
characteristics of GIS and why it is powerful in
education and in greater society.

Build skills in spatial analysis using ArcGIS
Online.
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What i1s GIS I?

1. Classical Definition: GIS is atool that can access,
Integrate, and distribute layers of map information. The
five parts of a GIS include hardware, software, data,
procedures, and people.

2. A more Modern Definition (?): GIS lets us visualize,
guestion, analyze, interpret, and understand data in

new ways. This can reveal relationships, patterns, and
rends.
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What is spatial thinking and analysis?
My working definition of spatial thinking:

“Identifying, analyzing, and understanding the location, scale,
patterns, and trends of the geographic and temporal relationships
among data, phenomena, and issues.”

Esri Definition of Spatial Analysis: “The process of examining the
locations, attributes, and relationships of features in spatial data
through overlay and other analytical techniques in order to address
a question or gain useful knowledge. Spatial analysis extracts or
creates new information from spatial data.

Or: It is how we understand our world — mapping where things
are, how they relate, what it all means, and what actions to take.
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Components of Spatial Analysis

- Understanding where.

- Measuring size, shape, distribution

- Determining how places are related
- Finding the best locations and paths

- Detecting and quantifying patterns

spatial ANALYSIS

- Making predictions AR T |

http://www.esri.com/products/technology-topics/spatial-analysis

https://dl.dropboxusercontent.com/u/91042629/The Lanquage of Spatial

Analysis 2013.pdf
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Is this spatial analysis?

ChangeMatters Viewer
Pan and zoom around the maps to understand earth changes that have happened over time. Advanced
change detection tools are also available by clicking any full screen button.
& Instructions
View larger

|| e

ChangeMatters = Infrared

Snow/Ice M urban Il vater [ A Clouds ¥ wetiands B veq Increase [ veg Decrease
.Agriculture -Conifer Forest -Desert -Broadleaf How to interpret a change image
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You need data and tools to do spatial analysis!

Finding and Using Spatial Data

Old Paradigm

--Download data=> Unzip-> Format-> Project=>Tabular
Manipulation-> Use.

New Paradigm

--Access data in cloud= Use.

We are not quite to the point of fully using the new
paradigm ... yet.
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Thus, best practice today is still the hybrid model.:
1. Start with ArcGIS Online to search for data.

2. Search local, state, national, international data
depositories and portals.

Examples:

Local: Boulder County CO, Los Angeles County CA

State: www.tnris.org (Texas), CASIL (California), RIGIS (RI)

National: USGS, NASA, Census Bureau, NOAA, EPA, US
DOT, USFWS, BLM, USFS, FAA, National Atlas,
LINZ (New Zealand), IBGE (Brazil), OS (UK)

International: WRI, WWF, UNEP, World Bank, Natural Earth

Data
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What kinds of data can you add to ArcGIS Online?

Data Type Open in ArcGIS  Open in ArcGIS
Online Desktop

Map Notes X

Tables (CSV) X X

Zipped Shapefiles X X Unzip first

Zipped other data X after unzipping X after unzipping
and serving

Images (JPG, X X

PNG, TIF)

Feature services X X

Layer package, X

map package
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Data Types and Sources

1) Vector: Shapefiles, geodatabases, feature
services, other vector formats.

2) Raster: ArcGrids, GeoTiffs and other images,
Tiled image services.

3) Tabular: Excel tables, CSVs, TXT files, other

formats.
4) Ground images: Wikipedia and other creative

commons sources.
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Data Sources and Issues (privacy, crowdsourcing,
cloud vs. desktop, copyright, and how to use).

The GIS Guide to Public Domain Data, by
Joseph Kerski and Jill Clark, Esri Press

http://spatialreserves.wordpress.com

Spatial Reserves

" About the book About the authors Exercises and data for the book Related sites

Type text to search here a

% Home > Public Domain Data > Listing of Free GIS Data Sources from Robin Wilson

Listing of Free GIS Data Sources from Robin Wilson

™ November 10, 2013 ) josephkerski ') Goto comments G} Leave a comment

As we discuss in the book The GIS Guide to Public Domain Data, listings of spatial data sources
have existed since the dawn of the web. Those of you who have been around GIS as long as
I have might remember such lists as the Oddens Bookmarks, which already contained over
5,500 categorized references by 1998, and the Alexandria Digital Library Project from UCSB.
The objective of these lists has always been, if not to eliminate, to at least reduce the need
for each of us in the field to maintain our own lists. While Internet search engines have vastly
improved over the past 20 years, listings still have their place and are still useful, because
search engines do not always pick up the relevant data and tools that the geospatial
community is seeking.

With the crowdsourcing tools available to us nowadays, though, is it not possible for
someone or an organization to create a crowdsourced listing of geospatial data? To maximize
the utility of such a resource would require someone vetting the list to make certain that only
relevant items are approved. Perhaps a reader can comment on this post to let the
community know if such a project exists or is in the works.

In the spirit of being helpful to the geospatial community, Robin Wilson, PhD student at the
University of Southampton, created the resource "Free GIS Data”

on http://freegisdata.rtwilson.com/. Robin's index is one of the more useful I have seen and
is frequently updated. It contains over 300 sources with headings of physical geagraphy,
cultural geography, as well as data about specific places. One of the most helpful things
about the resource is Robin's brief but very useful 1-2 sentences about each resource, which
serves as a useful bit of metadata to guide the user.

@ 1 freegisdata.stmilson.com
s ) oomsion @ o ove o

W et o

This page contains a categorised list of knks to over 300 sites providing freely avaiable,
geographic datasets - all ready for loading into a Geographic Information System.

RSS feed Q Twitter

Confributors

RecentPosts

@ The secret lives of phones: someone,
somewhere knows where you are
Digital Preservation and Formats from
the US Library of Congress

WorldPop - Population

distribution data

Listing of Free GIS Data Sources from
Robin wilson

Google's public data program

Recent Comments

The secret lives of phones: someone,
somewhere knows where you are |
GIS Tidings on The secret lives of
phones: someone, somewhere knows
where you are

Digital Preservation and Formats from
the US Library of Congress | Bhojaraju
Gunjal on Digital Preservation and
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10 Spatial Analysis Exercises
In the Public Domain Data Book

Exercises for GIS Guide to Public Domain Data book sucnto | Asoymap ¥ &
These 10 exercises for the GIS Guide to Public Domain Data book build skills in discovering, assessing, formatting, and using spatial data in a GIS environment, as well builder mode
analysis to make real-world decisions with those data. For more information, see http://spatialreserves.wordpress.com
SOUTH DAKOTA WISCONSIN
. Fierre /
Exercise 3
Sioux @ :
Falls . \\‘-—n“g\,;sl 5 W
; i o
Exercise 3: Siting a fire tower in the %, Madison
Loess Hills of Nebraska, USA &, %
Siting a fire tower o o _ Sawnop R R IOWA : e X
in Loess Hills, - = s 7 < @ % iy o Jgect
Nebraska % 1y NEBRASKA Des 07 7,
i et Moines .,
S : Lincoln
) Plyypte o]
\ 4
InE ise 3 det ine th timal sit D
Exercise 3: Siting a n Exercise 3, you determine the optimal site P
: 9 for a fire tower in the Loess Hills of Nebraska, Springfieldo
fire tower in the USA, by examining elevation, slope, aspect, §
Loess Hills of land cover, and distance to streams using Lo s JKansas City Saidh &
data from the USGS and a data conversion Topeka : 1500 re Moty
Nebraska, USA program. EANaAS Jefferson C|ty°' Missay,, oLouR,\ o
Y faYed A
Arkansas NHD Plus, NPS, Esri, DeLorme, FAO, USGS, EPA, NO... S i i

Exercise 3: Siting a fire
tower in the Loess Hills
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Finding and using data on ArcGIS Online

--Often helpful to narrow the search, such as:

quotes “riparian zones”

--Keywords:

<search string> owner:jjkerski or tags: “bike
lanes”

--Use Boolean operators:
“recent fires” OR fires
owner:esri AND tags:streets

--search in your specific map extent or in your
organization

More tips on: Using Search — Fields:
http://resources.arcqgis.com/en/help/arcgisonline/index.html#/
/010g0000000n000000

¢ Accessing and using data portals

@esri' Joseph Kerski — Webinar 13


http://resources.arcgis.com/en/help/arcgisonline/index.html

Access Boulder County GIS Portal

" =

< C'  [3 www.bouldercounty.org/gov/data/pages/gisdldata.aspx w =

2013 Flood | Home | Contact | Departments | Government | Elections | Jobs & Volunteer

] s

Open Space & Recreation Property & Land Roads & Transportation Environment Safety & Law Licenses, Permits & Records

Boulder County

Colorado

Government Geographic Information Systems (GIS) Downloadable Data

About Boulder County To access the data within the below files, use ArcGIS Explorer @ for layer packages and shapefiles and Google Earth @ for

Government KMZ format files. Roads may be accessed through the Colorado Depariment of Transportation @ (CDOT).
Bids & Purchasing

Boards & Commissions
Budget & Finance
Buildings & Personnel
County Ordinances
Departments
Economic Development
Elected Officials Building Footprints HTM (13 KB) KIMZ (6.5 MBYg) LPK (3.2 MBJf| ZIP (4.6 MB
Maps
GIS Downloadable Data .
News & Media rchacologically HTM (16 KB) KIMZ (50 KBJfF) LPK (340 KB)?) ZIP (18 KB

Public Meetings

“EFilter

Environmental

Conservation Areas HTM (53 KB) KMZ (176 KB LPK (285 KB)| ZIP (557 KB

Geological Hazards HTM (15 KB) KIMZ (699 KB LPK (1.0 MBJf| ZIP (706 KB

Mineral Resource Areas  HTM (15 KB) KIMZ (64 KB)E| LPK (134 KB)?| ZIP {66 KB

MNatural Communities,
Rare Plants, Riparian
Caorridors, Critical
Wildlife Habitat

HTM {519 KB) KMZ (130 KB LPK (203 KB)) ZIP (261 KB

Stgnificant Agrieulural pmy (17 kB) KIMZ (150 KBJE LPK (409 KBIF) ZP (151 KB

1, Floodplain (1).zip = ¥ show all downloads. .. x
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Save data sets locally, Add to ArcGIS Online via “My Content”

|4 Floodplain (1).zip

Add ltem

Add an item from your computer or reference an item on the Web.

The item is: | On my computer

File: Choose File |Floodplair|.zip

Supported Items
Contents: | Shapefile | =

Publish this file as a feature service
(Adds a feature service item with the same name.)

|Floodplair|

[Bnulder x] [Countv x] [ﬂnndplains »

Add tag(s)

ADD ITEM CANCEL

¥ show all downloads... %

Joseph Kerski — Webinar
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Using ArcGIS Online Analytical Tools

¢ ArcGIS Online is a cloud-based GIS, not just an online set
of web maps. Hence, you can use it for conducting spatial
analysis.

¢ The spatial analysis capabilities of ArcGIS Desktop still
far exceed that of ArcGIS Online, given its 30 year head
start, but more analytical capabilities are being added
guarterly to ArcGIS Online.

¢ The spatial analytical tools in ArcGIS Online are easy to
use. They are accessed from the arrows to the right of
specific layers. Whether you see the analytical tools
depends on (1) if you are using an ArcGIS Online
organizational subscription, and (2) how the data are served
In ArcGIS Online (i.e. ideally, as services)
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Activity 1. Cholera Analysis, London 1854

¢ Using Analytical capabilities in ArcGIS Online

¢ Problem Statement: What percentage of the cholera
outbreak cases are associated with the Broad Street and
other pumps?

You will consider public water pumps, and locations with
cholera cases in your assessment.
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Activity 2: Boulder County Flood Analysis

¢ Using Analytical capabilities in ArcGIS Online

¢ Problem Statement: Because of recent devastating
floods that occurred in September 2013, the Boulder County
Office of Emergency Preparedness, hearing of your
excellent GIS skills, has asked you to prepare an
assessment of the most vulnerable lands in the county to
future flooding and the people on those lands.

You will consider floodplains, geologic hazards, land cover,
soils, and demographics in your assessment.
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Analysis Workflow

¢ 1. Filter Floodplains layer to only consider the true
floodplains. Filter geologic hazards layer to only consider
Major Hazards.

¢ 2. Proximity-> Buffer floodplains by 200 meters.

¢ 3. Dissolve the buffer’s internal polygons.

¢ 4. Manage Data-> Overlay-> Intersect the dissolved
floodplain buffers with Major Geologic Hazards.

¢ 5. Sort on Analysis Area and only consider the largest
polygons.

¢ 6. Data Enrichment, with Group Quarters and %
Wetlands.
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Activity 3: A new road through the
Serengeti?

¢ Using Analytical capabilities in ArcGIS Online

¢ Problem Statement: A new road is proposed through the
Serengeti to link ports on the Indian Ocean with Lake
Victoria. You will use spatial analysis to examine the route
of two proposed roads, assessing the impact of each on
wildlife migration and on the local ecoregions, and
examining alternatives to the roads themselves.

You will consider the two routes proposed, wildlife
migration, ecoregion, elevation, total length. Specifically:
wildlife migration within 5 km from proposed roads, length
of roads within each ecoregion.
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Instructional Considerations

¢ You can have students perform the analysis.

- Or -

¢ You can perform the analysis and have the students analyze
the results (as | do often with the Serengeti lesson).

- Or -

¢ A combination of the two.

- Or -

¢ Teach with visual analysis of patterns, linkages, and trends,
without the quantitative measures.
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Next Steps

¢ Access these maps in ArcGIS Online. They are all public. Go through some
of these analytical steps.

¢ Take the Going Places with Spatial Analysis MOOC - Esri — Mar 2015.

¢ Examine “How to teach with the ArcGIS Platform” documents, including video
on spatial analysis tools:

http://www.esri.com/landing-pages/industries/education/higher-education/teach-
with-arcqgis-platform

¢ Review video tutorials: A Deeper Dive with ArcGIS Online:
See playlist : http://www.youtube.com/geographyuberalles
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